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Summary

This paper reviews the existing indices which have been developed for monitoring and quantitative
assessment of droughts, and analyzes their applicability for drought prediction and management in
the specific context of South Asia. It further describes the suite of routines, which have been
developed for automated estimation, display and analyses of various drought indices. The suite
forms part of the comprehensive computer package, developed earlier and designed to perform the
multitude of water resources analyses and hydrometeorological data processing. The seven-step
procedure of setting up and running a typical drought-assessment application is described in detail.






Introduction

Drought is a normal feature of any climate. It is a temporary, recurring natural disaster, which
originates from the lack of precipitation and brings significant economic losses. It is not possible
to avoid droughts. But drought preparedness can be developed and drought impacts can be managed.
The success of both depends, amongst the others, on how well the droughts are defined and drought
characteristics quantified.

Drought has many facets in any single region and it always starts with the lack of precipitation,
but may (or may not, depending on how long and severe it is) affect soil moisture, streams,
groundwater, ecosystems and human beings. This leads to the identification of different types of
drought (meteorological, agricultural, hydrological, socioeconomic), which reflect the perspectives
of different sectors on water shortages. These drought “types™ are in effect different stages (different
extremes) of the same natural and recurring process. The deficiency of rainfall starts a drought.
The longer and the more spatially extensive this deficiency, the more likely the occurrence of other
types of droughts.

Drought definitions vary from region to region and may depend upon the dominating perception,
and the task for which it is defined (academic study or a drought-relief plan). As a temporal, recurring
event, it should be generally defined relative to some long-term average condition (e.g., precipitation,
balance between precipitation and evapotranspiration, etc.). This is reflected in most of the general
drought definitions examples of which are given below.

e Drought is a period of abnormally dry weather sufficiently prolonged for the lack of precipitation
to cause a serious hydrological imbalance and carries connotations of a moisture deficiency with
respect to man’s usage of water (McMahon and Arenas 1982).

e The chief characteristic of a drought is a decrease of water availability in a particular period and
over a particular area (Beran and Rodier 1985).

e Drought is an interval of time, generally of the order of months or years in duration, during
which the actual moisture supply at a given place rather consistently falls short of the climatically
expected or climatically appropriate moisture supply (Palmer 1965).

* Drought is a severe shortage in the appearance of natural waters with respect to normal (Ben-
Zvi 1987).

e Drought is a condition whenever the amount of water which has been expected and relied upon
for use in any of man’s activities cannot be met for some reason (Takeuchi 1974).

These definitions are normally vague, do not provide quantitative answers to “when,” “how
long™ or “how severe™” a drought is and are often used as a startup in scientific papers and reports.
Some sources (National Drought Mitigation Center, Nebraska, USA) refer to them as “conceptual
definitions” and differentiate between conceptual and operational definitions of drought. Operational
definitions identify the beginning, end, spatial extent and severity of a drought. They are often region-
specific and are based on scientific reasoning, which follows the analysis of certain amounts of
hydrometeorological information. They are beneficial in developing drought policies, monitoring
systems, mitigation strategies and preparedness plans. Operational definitions are formulated in
terms of drought indices.



Review of Drought Indices

Drought indices are normally continuous functions of rainfall and/or temperature, river discharge
or other measurable variable. Rainfall data are widely used to calculate drought indices, because
long-term rainfall records are often available. Rainfall data alone may not reflect the spectrum of
drought-related conditions, but they can serve as a pragmatic solution in data-poor regions. Some
of the well-known and less-well-known indices used in drought studies, monitoring and management
are briefly reviewed below.

Palmer Drought Severity Index (PDSI)

Palmer (1965) developed a soil moisture algorithm (a model), which uses precipitation, temperature
data and local available water content (AWC) of the soil. AWC is in effect a “model parameter,”
which has to be set at the start of calculations. Calculations result in an index (PDSI), which indicates
standardized moisture conditions and allows comparisons to be made between locations and between
months. Details of a PDSI calculation may be found in Palmer 1965 and in many subsequent
publications (e.g., Alley 1984; Kim et al. 2002).

PDSI varies roughly between -6.0 and +6.0. More wet conditions are indicated by positive
values of PDSI, and more dry by negative values. The thresholds for the classification of different
wetness are arbitrary. PDSI values between —2 and +2 would normally indicate normal conditions,
although the sub-range of —1 to —2 could also be treated as a mild drought. PDSI in values in the
range of —2 to —3 are indicative of a moderate drought, -3 to —4 points to a severe drought and
values less than —4 would be associated with an extreme drought. Following Alley (1984), it could
be suggested that because the PDSI values are nondimensional, the value of -4.0 in southern
Afghanistan should have the same meaning in terms of the moisture departure from a climatic normal
as a -4.0 in the eastern Rajastan, India, for example. It may be argued that the extremity of a
drought should be defined in clear engineering terms, i.¢., in terms of its return period rather than
in terms of Palmer’s arbitrary thresholds. At the same time, using such thresholds may be much
more appealing (compared to return period) to nontechnical agencies.

PDSI values are normally calculated on a monthly basis. Further interpretation of monthly PDSI
allows drought duration to be taken into account as well. A drought sequence is interpreted as a
sequence of three or more consecutive months with a PDSI value < -2.0. A series of six or more
months is a major drought event. The end of a drought sequence is taken as the last month where
the PDSI 1s < -2.0.

Kogan (1995) suggested that PDSI had little acceptance elsewhere except in the USA. Tests in
other countries (e.g., du Pisani 1990; Bruwer 1990) found PDSI to be a poor indication of short-
term (i.e., periods of several weeks) changes in moisture status affecting crops and farming
operations. Some of the limitations of PDSI (e.g., sensitivity to AWC, arbitrary thresholds, no
account of river flow, liquid precipitation only, etc.) may be overcome by appropriate modifications
of the calculation procedures. However, PDSI values may lag behind emerging droughts by several
months. This limits its application in areas of frequent climatic extremes, like southwest Asia, where
large areas are dominated by monsoonal climates, for example. Also, the major problem associated
with using PDSI is that its computation is complex and requires substantial input of meteorological
data. Its application in Asia, where observational networks are scarce, is therefore limited.



Crop Moisture Index and Other Indices of Soil Moisture Conditions

The Crop Moisture Index (CMI), also developed by Palmer (1968), is a complement to the PDSI.
It measures the degree to which crop moisture requirements are met, is more responsive to short-
term changes in moisture conditions and is not intended to assess long-term droughts. CMI is
normally calculated with a weekly time step, is based on the mean temperature, total precipitation
for each week and the CMI value from the previous week. Each growing season, CMI typically
begins and ends near zero. It is, in principle, possible to use a combination of PDSI and CMI for
drought monitoring, where PDSI would serve as a long-term drought-monitoring tool, whereas the
CMI may indicate the progression of seasonal water shortages during a crop-growing stage.

A number of other indices, which focus on soil-water availability for crops, have been developed.
As a rule, these methods calculate the soil-moisture balance with 1-, 5-, 7- or 10-day time steps
and then compute some integral measure (an index) that indicates the degree to which the crop-
water requirement has been met. This group of indices includes FAO water satisfaction index (Frere
and Popov 1979), Agro-Hydro Potential ([AHP] Petrasovits 1990), Index of Moisture Adequacy
([IMA] Rao et al. 1981; Sastri 1993) and Moisture Availability Index (|MAI] Heddinghaus 1991).
Tate et al. (2000) list some other similar indices, which are normally developed for the purpose of
agro-meteorological crop monitoring and yield prediction.

Standardized Precipitation Index (SPI)

SPI was developed in Colorado by McKee et al. (1993) and is based just on precipitation and,
therefore, requires less input data and calculation effort than PDSI. A long-term precipitation record
at the desired station is fitted to a probability distribution (e.g., gamma distribution), which is then
transformed into a normal distribution so that the mean SPI is zero (Edwards and McKee 1997).
SPI may be computed with different time steps (e.g., 1 month, 3 months..., 48 months) and is reported
to be able to identify emerging droughts sooner than the Palmer Index. The use of different time
scales under the umbrella of the same index allows the effects of a precipitation deficit on different
water-resources components (groundwater, reservoir storage, soil moisture, streamflow) to be
assessed.

Positive SPI values indicate greater than mean precipitation and negative values indicate less
than mean precipitation. Similarly, to the PDSI, SPI may be used for monitoring both dry and wet
conditions. The “drought™ part of the SPI range is arbitrarily split into “near normal” conditions
(0.99 <SPI<-0.99), moderately dry (-1.0 < SPI < -1.49), severely dry (-1.5 <SPI<-1.99) and
extremely dry (SPI < -2.0). A drought event starts when SPI value reaches -1.0 and ends when
SPI becomes positive again. The positive sum of the SPI for all the months within a drought event
is referred to as “drought magnitude.”

To date, SPI is finding more applications in southwest Asia than other drought indices due to
its limited input data requirements, flexibility and simplicity of calculations.

Effective Drought Index (EDI)

Unlike many other drought indices, the EDI in its original form (Byun and Wilhite 1999) is calculated
with a daily time step. EDI is a function of precipitation needed for a return to normal conditions
(PRN). PRN is precipitation, which is necessary for the recovery from the accumulated deficit since
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the beginning of the drought. PRN, in turn, effectively stems from daily effective precipitation (EP)
and its deviation from the mean for each day.

Like SPI, EDI values are standardized, allowing drought severity at two or more locations to
be compared with each other regardless of climatic differences between them. The range of EDI
variation is from -2 to 2. Like PDSI and SPI, it has thresholds indicating the range of wetness,
from extremely dry to extremely wet conditions. The “drought range” of EDI indicates extremely
dry conditions at EDI < -2, severe drought at —1.5 < EDI< 1.99 and moderate drought at —1 <
EDI < -1.49. Near normal conditions are indicated by -0.99 < EDI< 0.99.

EDI as the measure of drought has been suggested recently and has not yet received much
attention in the context of southwest Asia. It is, in principle, applicable to drought monitoring over
large regions. The major problem associated with EDI in its original form is that it is based on
daily precipitation data. These data, although naturally existing, are much less readily available
from government agencies in the region at present. At the same time, the EDI may be similarly
calculated using monthly step data. It is logical and appealing to test EDI performance (compared
to other drought indices) if monthly precipitation data are used as input.

Surface Water Supply Index (SWSI)

This index was developed in Colorado (Shafer and Dezman 1982) and is adopted by several
American states (Oregon, Montana, Idaho and Utah), where snow forms a large component of the
water balance. SWSI integrates reservoir storage, streamflow and two precipitation types (snow
and rain) at high elevations into a single index number. SWSI is expressed as

_ apmow + prrec + CI:)strm
12
where, a, b, ¢, and d = weights for snow, rain, streamflow and reservoir storage, respectively, (a +
b +c+d=1)and P, = the probability (%) of non-exceedence for each of these four water-balance
components. Calculations are performed with a monthly time step. In winter months, SWSI is

+dP_, -50

computed using snowpack, precipitation and reservoir storage. In summer, streamflow, precipitation
and reservoir storage data are used. For each month, the values of each component measured at all
stations (or reservoirs) across the region/basin are summed. Each sum is normalized and its non-
exceedence probability is determined. Weights are assigned to each water-balance component
depending on its typical contribution to surface water within a basin. Subtracting 50 and dividing
by 12 constitute the normalization procedure designed to make SWSI values to have a similar range
as PDSI (4.2 to +4.2).

SWSI is relatively easy to calculate and it gives a representative measure of water availability
across a river basin or a selected region/province. However, it is unlikely that it could be successfully
used for large regions with significant spatial hydrological variability; the weights may differ
substantially from one part of the region to another (¢.g., Doesken et al. 1991). If the measurements
at any station are discontinued, observations on one or more components are interrupted and new
frequency distributions need to be calculated. Similarly, new dams or diversions in the basin/region
will require modification of weights for each water-balance component. Therefore, it is difficult to
maintain a homogeneous time series of SWSI. In addition, extreme events may cause a problem:
if they have not been recorded previously, a frequency distribution of a relevant component needs
to be revisited. This may be a serious limitation for the use of SWSI in southwest Asia, which



hosts a variety of climates, from the monsoon-dominated areas to arid zones with limited lengths
of historical hydrometeorological time series. More information on SWSI may be found in Doesken
et al. 1983, 1991.

A modification of SWSI is known as the Reclamation Drought Index (RDI), used in Oklahoma,
USA, as part of its drought management plan (as a trigger for drought-relief funds). Its calculation
is similar to that of SWSI, but it also includes an evaporation component. The RDI range and
thresholds are similar to those of PDSI and SWSI. Normal to mild droughts occur when RDI values
are 0 to —1.5, moderate drought when RDI is within —1.5 to —4.0. If RDI is less than —4.0 the
drought is severe. The similarity between RDI and SWSI implies that RDI also has similar
limitations, although RDI may be adapted to any region as it takes into account both climatic and
water-supply factors. There is no indication to date that SWSI or RDI has been used for drought-
monitoring in South Asia.

Deciles

In this approach suggested by Gibbs and Maher (1967) and widely used in Australia (Coughlan
1987; Smith et al. 1993) monthly precipitation totals from a long-term record are first ranked from
highest to lowest to construct a cumulative frequency distribution. The distribution is then split
into ten parts (tenths of distribution or deciles). The first decile is the precipitation value not exceeded
by the lowest 10% of all precipitation values in a record, the second is between the lowest 10 and
20%, etc. Any precipitation value (e.g., from the current or previous month) can be compared with,
and interpreted in terms of these, deciles. A reasonably long precipitation record (30-50 years) is
required for this approach. This is not a shortcoming of the method, but rather a requirement of
the statistical analysis. Decile Indices (DIs) are grouped into five classes, two deciles per class. If
precipitation falls into the lowest 20% (deciles 1 and 2), it is classified as “much below normal.”
Deciles 3 to 4 (20 to 40%) indicate “below normal” precipitation; deciles 5 to 6 (40 to 60%) give
“near normal” precipitation; deciles 7 to 8 (60 to 80%) give “above normal;” and deciles 9 to 10
(80 to 100%) are “much above normal.” The DI is relatively simple to calculate, requires only
precipitation data and fewer assumptions than more comprehensive indices (like PDSI or SWSI).
Due to the above, the method may be appropriate for conditions in southwest Asia.

Percent of Normal and Other Rainfall Deficiency Indices

These indices are simple, by definition, easy to calculate and are easily understood by a general
audience. “Normal” may be, and usually is, set to a long-term mean or median precipitation value.
It may be calculated for a day, a month, a season or a year and is considered to be 100%. The
same percent of normal may have different specific impacts at different locations and, therefore, it
is a bit of a simplistic measure of precipitation deficit. Also, what is normal may be perceived
differently in different regions.

There are multiple definitions of a drought based on the percent or a proportion of normal.
Bates (1935) suggested defining droughts in USA when annual precipitation is 75% of normal
or monthly precipitation is 60% of normal. Banerji and Chabra (1964) considered severe drought
conditions in the State of Andhra Pradesh, India to be coincident with a seasonal rainfall deficit
of more than 50% (which means rainfall of less than 50% of normal). Ramdas (1950), also in
India, considered a drought to arrive when actual rainfall for a week is half of normal or less.



Generally, meteorological drought in India is defined when rainfall in a month or a season is
less than 75% of its long-term mean. If the rainfall is 50-74% of the mean, a moderate drought
event is assumed to occur, and when rainfall is less than 50% of its mean a severe drought occurs.
Droughts in South Africa are defined as periods with less than 70% of normal precipitation.
This becomes a disaster or severe drought when two consecutive seasons experience 70% of
normal rainfall or less (Bruwer 1990). There are many other similar indices and associated drought
definitions. They are normally region-specific and explicitly set locally appropriate rainfall limits
and duration of rainless periods for the definition of droughts of different extremities.

Drought Indices Derived from Flow Data

Most of the indices described above are derived from the meteorological observations (precipitation
primarily, and temperature). These data are normally readily available throughout the world
(compared to other data types), which partially explains the variety of such indices and the general
popularity of this approach. Droughts may also, and should, wherever possible, be assessed and
monitored using other types of data (e.g., river flow).

In river hydrology, droughts are often referred to as periods of low flow. The international
glossary of hydrology (WMO 1974) defines low flow as a “flow of water in a stream during
prolonged dry weather.” This definition does not make a clear distinction between low flows and
droughts. Low flows are a seasonal phenomenon, and an integral component of a flow regime of
any river. Drought, on the other hand, is a natural event, which results from less than normal
precipitation for an extended period of time and affects more than just river flow. Drought is therefore
a more general phenomenon, and may be characterized by more factors than just low flows. Droughts
include low-flow periods, but a continuous seasonal low-flow event does not necessarily constitute
a drought, although many researchers refer to a continuous low-flow period in one year as an “annual
drought™ (e.g., Zelenhasic and Salvai 1987; Clausen and Pearson 1995; Tallaksen et al. 1997).

The review of low-flow analyses and indices may be found in Smakhtin (2001) and is not
repeated here. Some of these analyses focus on the frequency of flow minima or on how fast the
flow in a river recedes in the absence of rain. Others, like flow-duration curves, are somewhat
similar to the already-mentioned deciles. As a rule, these analyses do not allow the start and end of
dry periods to be determined directly. In the drought context, the most relevant type of hydrological
analyses is perhaps the analysis of continuous periods during which a flow in a river stays below
some predefined threshold(s) (often referred to as reference discharge or truncation level). These
periods are known as “spells,” or “runs” (Yevjevich 1967; IH 1980; Dracup et al. 1980 a, b;
Zelenhasi and Salvai 1987; Bonacci 1993).

The spell or run analysis may be performed on data with any temporal resolution from daily
(Zelenhasi and Salvai 1987) to annual time steps (Sen 1980). A number of consecutive time intervals
where the selected flow variable (a discharge or flow volume) has lower values than a reference
flow level indicate the duration of a drought event. For each such event, the sum of deviations of
a flow variable from the reference level represents the cumulative flow-deficit amount (drought
severity). This deficit divided by the duration is the measure of drought intensity. After all drought
events in the available flow time series are identified and their characteristics are calculated, a
frequency analysis is performed on them. This analysis allows the return periods of these drought
characteristics to be estimated. The procedure may be repeated for different reference discharges.



From the water-resources management perspective, it is important to define the reference flow
levels and indicators of drought severity (what drought duration and/or flow deficit constitutes mild
or severe drought). While these indicators would normally differ from region to region, some existing
definitions of water shortages may serve as a starting point (Dracup 1980a).

* A deep shortage - when annual runoff is lower than the mean, by at least one standard
deviation.

* A continuous shortage - when annual volumes are lower than the mean, during at least 4
consecutive years.

* An extended shortage - when a deep or continuous shortage extends over the entire
region under consideration.

The same threefold definition approach may be modified and extended to the attempts to define
drought using data with temporal resolution smaller than 1 year.

Apart from the river flow, reservoir storage is also a useful indicator of water shortages, due
to data availability, often on a daily or weekly basis. At the same time, these data are strongly
influenced by the reservoir-operation rules. Also, drought may be defined in terms of the differences
between water supply and water demand time series. The supply time series may be represented
by a river flow and the demand time series by the demand of a particular user (e.g., irrigation) or
by the total demand of all users. When demand exceeds supply, water shortages occur representing
the start of a drought. Tate et al. (2000) provide examples on supply-demand issues related to
reservoir operations, while Smakhtin (2001) lists multiple other references on the topics of low-
flow spell and storage-yield analyses.

The analysis of river flow data for any purpose, including drought management is however
often hampered by the lack of such data, shorter records available (compared to rainfall, for
example), artificial influences (e.g., catchment land-use change, effluents, abstraction), etc. In
addition, in the context of Southwest Asia, flow data are often of poor quality and are not easily
available from relevant authorities, at least at present. Drought indices and definitions based solely
on flow or reservoir storage are normally designed for reservoir operation and are seldom (if at
all) used as triggers for drought relief, or for drought monitoring over vast territories. As has been
shown above, some general indices of water availability (e.g., SWSI) explicitly include reservoir
storage and river flow time series available in a region into calculations..



Requirements for Automated Drought Analyses

No drought index is ideal for all regions or tasks. In most cases, it is useful to consider more than
one index, examine the sensitivity and accuracy of indices, the correlation between them, and explore
how well they complement each other in the context of specific research or management objectives.
Therefore, an estimation package is needed that allows multiple drought indices to be estimated,
displayed and analyzed. While several computer programs have been developed to estimate individual
indices separately (e.g., SPI), no comprehensive, multipurpose software for drought analysis is
available at present.

Most of the drought indices described above deal with drought at a single location (e.g., rainfall
station). For drought-mitigation and -management purposes, it is necessary to establish the area
hit by a drought and/or the levels of drought severity in different parts of a region. Values of drought
indices may be plotted over the region at different administrative or physiographic resolution (talukas,
districts, states, river basins) to quantify the areal distribution of a drought at different time intervals
(months, seasons, etc). While GIS maps of drought characteristics may be constructed at present
for an area, the transfer of data for different indices, between different software packages for drought-
monitoring purposes (at regular time intervals) is not very efficient. It is beneficial to have, in one
software package, the routines that allow point to area conversion of rainfall deficits and drought
indices to be made, and quick spatial analyses of different drought characteristics to be performed.

Regional drought analyses often imply that hydrometeorological and other data from different
sources and in different formats have to be processed. The ability to work with multiple data formats
is the important required feature of drought-analyses software.

Droughts may affect multiple components of a hydrological cycle. Often, the application of
hydrological, ecological and water-resources models is required to analyze different components
of droughts and to interpret their outputs using various drought indices. It is beneficial to ensure
that such models are available and can be run within the same software environment.

Considering the number and magnitude of requirements listed above, it is logical to consider
incorporating the drought-indices estimation and analyses routines into some existing software
package, which already has some of the required features, which is flexible enough to work efficiently
with large datasets, and which is cost effective and permanently developing to include more analytical
components.



Incorporating Drought Indices into the Spatsim Software Package

Background

A SPATSIM (SPAtial and Time Series Information Modeling) software package has been developed
by the Institute for Water Research (IWR) of Rhodes University in South Africa during 1999-
2002. It is a relatively new software product, which is quickly gaining recognition in South Africa
and other countries.

The package has been developed in Delphi using ESRI Map Objects as a tool for managing
and modeling the data that are typically associated with water-resource assessment studies. It
contains an integrated database-management system that uses GIS Shape files as the main form of
data access. It also has a number of built-in data-analysis and processing tools (such as for generating
catchment average rainfall data from gauged station data or generating monthly and annual frequency
tables from time series), as well as a wide range of external models that can be set up and integrated
seamlessly with the database (i.e., the models access their data requirements from the SPATSIM
database and store their results in the database without any intermediate data transformation). The
models include Design Flood, Spatial Interpolation of Observed Flow Records, Monthly Rainfall-
Runoff Simulation Model (Pitman Model), Desktop Model for Environmental Flow Assessment,
etc. Detailed SPATSIM description and ‘Help” options are available with the installation package
and are not repeated here.

Until recently, the SPATSIM software had no specific routines to address issues of drought
assessment or management. However, its flexible environment provides an excellent opportunity to
incorporate such routines, extending the capabilities of the software package and addressing the
requirements of IWMI’s drought-assessment and mitigation project in southeast Asia. With regard
to the SPATSIM package, these requirements included the following amongst others:

* To ensure that existing data-import facilities are satisfactory for the southwest Asia region.

e To add a facility for generating time series of drought indices from station rainfall data and from
areal rainfall data interpolated from station (i.e., point) rainfall data.

»  To provide facilities for further display and regional analysis of drought indices.

e To document all the new facilities in the SPATSIM ‘Help’ system.

Summary of Facilities Added to SPATSIM

A number of additional menu items have been added to SPATSIM to cater to the estimation of
drought indices. In addition some of the existing facilities have been extended or improved.

* A comprehensive drought index estimation routine has been added that makes use of all available
rainfall time series associated with a specific SPATSIM time series attribute and generates time
series of 5 drought indices which include: SPI, EDI, Decile and departures from means and
medians (see the description of indices above). The results are saved to a SPATSIM time series
attribute for further analysis and display. The user has the flexibility of choosing different



durations, starting months and data-integration types (running means, for example). This is
important in the context of southwest Asia, if the analysis is to be made for cropping seasons,
for example kharif () and rabi () in India, which have different durations and starting months.

A facility to summarize a drought-index time series as a table of selected drought index values,
or as the statistics of a run (or spell) analysis of a drought-index time series.

New “Help’ items that explain the use of the above two facilities as well as the origin of the five
drought-index types (SPI, EDI and Deciles, and departures from the mean and median).

Additions to the spatial rainfall interpolation methods that were already part of SPATSIM. The
additions allow all polygons within the displayed part of a map to be selected and used in the
interpolation procedure, while previously the selection was based on linked catchment areas only.

The addition of a facility to generate a gridded polygon coverage that can be used for rainfall
interpolation in the absence of available polygon coverage based on catchments or administration
areas (for example). This was added mainly to extend the range of options for spatial mapping
of drought indices.

The generic (in-built in SPATSIM) time series display and analysis program, TSOFT, has been
modified and improved to account for some of the issues that emerged during the project (mainly
associated with consistency in date formatting and position plotting).

A ‘Drought Index Road Map’ has been added to the ‘Help’ system to provide step-by-step
guidelines to the use of the new facilities.

A few other improvements have been made to SPATSIM to address small problems that emerged
during the extensive testing of the “drought estimation software™ that had previously not been
identified. One of these is a check to ensure that shape files being used with SPATSIM have the
required internal attributes as part of the table (one field of unique integer values to be used as
the ID field and a further numeric or text field to be used as the Description field).

An example database and SPATSIM application based on shape files and rainfall data from
southwest Asia have been established. The rainfall data used were provided by the Pakistan
Meteorology Department and the India Meteorology Department.

The following section provides further details of the procedures that should be followed in setting
up a typical application of SPATSIM for assessing point or regional drought characteristics.

Setting up a Typical Application

The details of the new facilities have been included in the standard SPATSIM ‘Help’ (see the main
‘Help” section and the Drought Index component under Procedures). Reference is made to the
relevant “Help” topic where appropriate. It is the responsibility of all new users to consult the “Help’
system to obtain a basic understanding of the SPATSIM system and how to make use of the various
menu items. It is a frequent practice for new users to attend a 2- to 3-day introductory course on
the use of the software. However, this is not possible in this case and, therefore, a greater reliance
was placed on using the ‘Help” system. Additional example applications from recent case studies
in South Asia, with data and guidelines, are also available at IWMI.
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Step 1: Organize spatial coverages (SPATSIM features)

SPATSIM uses spatial features (coverages) and temporal attributes (time series, figure 1). The
assumption is that there will be at least two coverages: one point coverage representing rain-gauge
locations for raw monthly rainfall data and one polygon coverage representing administrative areas
or catchments. If the latter is not available, the facility ‘Features” -> *Create Grid Feature” can be
used to establish a new polygon coverage of equal-size grid squares. This can then be used to
generate the areal rainfall data from the point rainfall and then to display the spatial variation of
drought indices.

Figure 1. The main SPATSIM screen, showing the study area, with the selection windows for
available spatial features and associated attributes.
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The SPATSIM ‘Help” system should be consulted about the rules for using shape files with
SPATSIM and the need for internal shape file attributes for the identification number and description
information. In brief terms, all shape files used with SPATSIM should have one internal integer
type attribute that contains a unique value for each spatial element (point, polygon or line). This
(the ID Field) is used for database cross-reference within the SPATSIM system and cannot be
changed once set. The second internal attribute (the Description Field) can be either numeric or
text and is used for importing data and for labeling. This attribute can be changed at any time.
When a shape file is added to SPATSIM for the first time, checks are made to ensure that the
shape file attributes are of the correct type.

Step 2: Create main SPATSIM attributes

It is necessary to design the SPATSIM attribute structure to store and manage the raw and
processed data. This simply involves adding new attributes of different types and giving them
suitable names that can be recognized later. For the rain-gauge point coverage, the minimum
requirement will be a time series attribute that will be used to store the raw monthly rainfall
data. For the polygon coverage that will be used for generating the spatially distributed drought
indices, a wide range of attributes will be required depending on the analyses intended. At least
a time series attribute will be needed that will be used to store the areca-average rainfall data
interpolated from the point rainfall data.

Additional time series attributes will be required for each drought index that is to be generated
and it is important to name these carefully so that they can be readily identified in the future. For
example, there are many different types of SPI values that can be generated depending on the type
of analysis and duration of the integration period. The user should choose names that make sense
and can identify the drought index clearly. Add a memo index and fill in some more details and a
longer explanation of what the attributes mean. This information will only be added for a single
polygon and it will be necessary to remember which polygon was used so that it can be retrieved
and viewed at any time.

Figure 2 indicates that there is a wide variety of index values that can be generated and users
could get very confused trying to remember which drought index has been stored in which attribute.
That is why it is essential to use recognizable names for the attributes. For example, ‘SPI 3m Jan
Annual’ could be used for an SPI based on a single annual value with a 3-month duration starting
in January; ‘SPI 6m RunMean’ might be used for an SPI value based on 6 month running means.
The lower right hand box displays all the available attributes that have been established in an
example application, provided with the package.
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Figure 2. Main drought index generation screen showing the various drought index options that
are available.
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Step 3: Import raw rainfall data

The standard time series import routines (see “Attribute -> ‘Import or Edit’ -> ‘Import T/S’) are
used to load suitably formatted text files of monthly rainfall data to the SPATSIM time series
attribute associated with the point rain-gauge feature. There are a wide variety of options available,
but the most common are the “spreadsheet™ type (year plus 12 monthly values per line in a text
file with a defined number of explanation lines above the data, called the header) and the “continuous
data” type (the start date, day/month/year, followed by one data value per line). Common problems
are related to the lack of line feeds and carriage return codes at the end of the text lines when
exported from other specialist software. These can be usually solved by importing the data into a
text editor and then simply saving the data.

The normal method used for importing point time series is to name all the text files containing
the data the same as the Description Field value of the points in the shape file. These are the labels
that are displayed on the map. For example, we assume a point coverage has 4 spatial elements
with Description Field entries of 42328, 42237, 42339, 42435 (in this case, these entries are the
rain-gauge codes of the India Meteorology Department). We then prepare the rainfall data as text
files with names 42328 .dat, 42237 .dat, 42339.dat, 42435 .dat and all with the same format in terms
of header lines, etc. After starting the import routine (‘Attributes” -> ‘Import or Edit” -> ‘Import
T/S’), we accept the default import file selection options of “Select Multiple Files” and ‘From
Filename’ and select the four files. Now we select the appropriate input file type, set the various
associated options describing the file format, ensure that the T/S attribute settings are correct



(the user is recommended to consult the “Help” utility on variables and units for the meaning of the
different attribute values) and click the ‘Continue with Import” icon button (top right). The data
will now be imported for all four points and a summary of the import process reported in the box
on the left.

Step 4: Generate areal rainfall data

The ‘Procedure’ -> ‘Point to Area’ facility is used to generate arcal rainfall data for a polygon
feature from the point rainfall data (see the relevant “Help” topic under ‘Procedures’). Unless the
polygon feature to be used represents catchments for which the downstream connections have been
identified and stored (in a text attribute), it will be necessary to use the ‘zoom area’ sub-option to
select the polygons for which areal rainfall data are to be generated.

There is no missing data-filling procedure available within SPATSIM at present (i.¢., one cannot
fill missing data for a single rainfall station). However, the areal rainfall-generation procedure fills
missing data and generates complete records for all the polygons to be used. If the procedure cannot
find rainfall values at any station within the defined search radius, mean monthly rainfall values
are substituted. This can be a problem if there are extended missing data periods within several
rain-gauge time series in the same area. However, the problem is usually quite easy to recognize
as a repeating pattern of rainfall will be seen in the areal rainfall time series (viewed using the
TSOFT facility, the part of SPATSIM, designed to display time series information).

Once the areal rainfall data have been generated, it is always good practice to use TSOFT to
check the interpolation procedure. A sample of areal rainfall time series is loaded into a TSOFT profile,
as well as the point rainfall data that will have been used to generate the arcal data. The user can
then visually compare and inspect the data series to ensure that the areal interpolation process has
worked successfully. The main problems that can occur are related to too many missing data in the
raw data, an inappropriate search radius, insufficient rain gauges in a particular area, or the selection
of too few (or too many) rain gauges on which to base the interpolation.

The ‘Help” system provides information on how to load time series into a TSOFT ‘profile’
(simply a cross-reference to the SPATSIM database). Select the “Application” -> “T/S Graphs’ ->
‘Select first” option, enter the name of a profile (either new or existing) and then highlight the required
attribute and click on the spatial elements for which the attribute data are to be plotted. Once TSOFT
is running, use its internal options to select which time series in the profile to display and analyze.

Step 5: Generate drought indices

This step is based on using the ‘Procedure” -> ‘Drought Indices” -> ‘Generate Index T/S” menu
option to generate time series of a wide range of indices from complete time series of monthly
rainfall data. The current feature is normally the polygon coverage and the current attribute a
time series of rainfall, within which there is no missing data.

A user can select from various options for different index types (see the ‘Help” system — SPATSIM
Help -> Procedures -> Drought Indices) and ensure that the destination attribute selected for storing
the data has an appropriate name to identify what data are being stored. This step can be repeated
for as many different index types as required. Figure 2 illustrates the various options that are available.
The analysis options and duration selections are disabled if they are not appropriate to a specific
index that has been selected.
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Users are advised to look through the literature on the various drought indices to obtain more
insight into their derivation and functioning. The SPATSIM ‘Help’ facility is helpful, but only provides
a brief summary (figure 3). At the same time, it explains, amongst the others, the modifications which
have been made in the algorithms of specific drought indices. These modifications include an effectively
new algorithm for EDI (as it is used now with monthly rainfall data as opposed to daily data in the
original), waiving the original probability categorization into 10 DI classes in favor of estimating the
actual cumulative probability, etc.

Figure 3. Example screen of ‘Help’ facility in SPATS M.
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Once the drought index time series have been generated, they can be compared using the standard
TSOFT facility (for example, compare the same index for several areas, or compare different index
time series for the same area).

Step 6: Generate summary drought index information

The “Help’ system and figure 4 indicate that two types of summary information can be generated
using the ‘Procedure” -> ‘Drought Indices’” -> “‘Save Summary Information.” Both can be generated
at the same time.
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Figure 4. Saving drought index information to a summary table (array type attribute).
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The first option is a single index value extracted for up to 10 sample years from a time series
of drought-index values and stored in a 2-D-array-type attribute that also stores the year. Once
again, note that summary data for many different drought indices could be stored and, therefore,
the naming approach for the attributes within SPATSIM is very important. The memo attributes
help the user to remember what information is stored within which attribute. The choice of storing
a sample of 10 values is quite arbitrary, but it is based on the assumption that a larger number
would be rather unnecessary and, if required, could be stored within more than one summary
attribute. In certain cases (i.e., where there are multiple drought-index values per year), it is necessary
to select not only the years but also the month for the required drought index. While multiple years
can be selected, multiple months cannot (i.e., users may select several years for the period JAS,
but they cannot select JFM, AMJ, JAS and OND for 1968) to avoid confusion. The same set of
years but with a different month group may however be selected and stored.

The second option is a summary of the run (or spell) characteristics of the index data (i.e., for
how long a drought index lies below and above a certain critical threshold). The analysis is based
on the time series attribute that is current at the time of running the procedure (i.e., highlighted in
the list of attributes when the ‘Procedure’ -> ‘Drought Indices” -> ‘Save Summary Information’
process is started). This process can, therefore, be repeated as many times as necessary to generate
summary data for all the drought indices generated during step 5.
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Step 7: Visualizing drought-summary information

No new facilities have been added to SPATSIM to specifically visualize drought indices. This is
because the generic facilities for viewing time series (TSOFT routine) and rendering maps, with
cither single values or values selected from array attribute tables, should be sufficient.

The time series of drought indices for a range of polygons (or different index types for the
same polygon) can be readily compared using the normal TSOFT facilities (figure 5). Within TSOFT
the normal analysis facilities are available to show duration curves (for example) that can be used
to assess the frequency characteristics of the drought indices for a range of polygons.

The summary information can be used to render polygon coverages to show the areal extent
and pattern of droughts for a specific year (or season of a year). The summary information can
also be used to map the run or spell characteristics of different areas. In both cases, it will be
necessary to select the summary information required from one of the stored array attributes using
the “Attribute’ -> ‘Render’ > ‘Set Array Element” menu option (figure 6). Make sure that an array
attribute is highlighted in the attribute list before starting this procedure. The user can also specify
a title for the specific rendering process.

Figure 5. Example TSOFT screen showing graphs of areal monthly rainfall for the selected polygon
and time series of several SPI values for different durations.
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Once the array element has been selected, the “Attribute” -> ‘Render” -> “Start” option is selected
and the ranges and colors of the drought index categories can be set (figure 7). For the SPI index
it has been found useful to set the minimum value to —2.5, the interval to 0.5 and the number of
groups to 9 (see below). The user has the full flexibility of defining drought categories in any way
desired. Note that the generic rendering procedure cannot distinguish the type of data being used
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for rendering and the user is asked whether the data are based on less than 32 unique integer values.
This is to distinguish between the so-called ‘class break” rendering (answer NO), or ‘group’ rendering
(answer YES). For drought indices the answer is always NO. Referring to figure 7, it is useful to
recognize that setting the interval to a number other than —9, means that the maximum value setting
is ignored.

Figure 6. The two options for selecting part of a table within an array attribute for use with the
map rendering system. The left-hand one for the summary of up to 10 years of drought index values
and the right-hand one for run (or spell) details.
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Figure 7. Rendering design page for setting the parameters (colors, data range and maximuny
minimum val ues).
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The final result is a map of color-coded index values for those polygons that have data associated
with them (figure 8). To start another rendering with a different index, remove the existing one and
start the process again. To identify the colors toggle between the ‘Maps” page and the ‘Render’
page. A legend is not drawn on the map as facilities to do this neatly are not available within the
Map Objects development software. It is possible that a better way of doing this will be found in
the future.

Figure 8. Rendered map of southwest Asia showing spatial distribution of the drought index selected
for a particular month.
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Conclusions

The review of drought indices has highlighted a few indices and associated analysis options, which
could be suitable for drought monitoring in South Asia. A flexible package for automated estimation
and analyses of drought indices has been developed and added to the existing comprehensive software
for water-resources analyses (SPATSIM). All new SPATSIM facilities have undergone preliminary
testing at both IWMI and IWR. The description of the software is available on IWR web site http:/
/www.ru.ac.za/institutes/iwr/. Additional example applications for users in the region will be placed
on the web site of the regional Drought Project http://www.iwmi.cgiar.org/droughtassessment/
index.asp. It is recognized that further testing and user-experience are required before the
development of the software can be considered a fully finished product. There is a great deal to
test due to the many options that are available for selecting the index type, and it has not been
possible to thoroughly test all of these during the relatively short duration of this project. However,
the IWR and IWMI are committed to continuing to support the development of the drought-index
components of SPATSIM and will respond to comments and suggestions from various future users.
While the Institutes may not have the resources available to make extensive changes and to add a
large number of new facilities, they certainly have the resources to carry additional testing through
new applications and/or correct any errors and to add small improvements.

The same applies to the ‘Help” facilities associated with the drought-index developments. These
will be added to and improved whenever problems, or better ways of explaining methods, are
identified. It can be noted, however, that individual users have the ability to modify their own versions
of the ‘Help’ files. They are all stored within the SPATSIM/DOCS folder and are simply html files
that have been created using Microsoft Word. If an update to the users system is downloaded from
the IWR website, it is possible that the html file that the user changed has been updated by the
IWR. In this case, the users file will be overwritten and special arrangements will have to be made
to save the modified file to a different location and then restore it after the update is completed.

The addition of drought-estimation routines has certainly enhanced the value of the SPATSIM
software. It also provided specific target groups in South Asia with a comprehensive modeling-
and data-processing tool, which may be used for regional drought analyses and for a multitude of
other water-resources applications. The same package may be used by different responsible agencies
and organizations in countries of the region, which can create a regional community of practice,
where assessments are made using the same algorithms and software and where, therefore, the results
can be casily exported, imported, reproduced and analyzed at different physical locations. The
software developed should be a useful addition to decision-support tools for drought mitigation in
the region.
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